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Preface

For details, see the following topics:

• Progress Corticon documentation

• Overview of Progress Corticon

Progress Corticon documentation
The following documentation, as well as a What's New in Corticon document, is included with this
Progress Corticon release:

Corticon Tutorials

Introduces modeling, analyzing, and testing rules and decisions in
Corticon Studio. Recommended for evaluators and users getting
started. See also the PowerPoint-as-PDF version of this document
that is accessed from the Studio for Analysts' Help menu.

Corticon Studio Tutorial:
Basic Rule Modeling

Provides a deeper look into Corticon Studio's capabilities by defining
and testing vocabularies, scope, collections, messages, filters,
conditions, transient data, and calculations in multiple rulesheets that
are assembled into a Ruleflow. See also the PowerPoint-as-PDF
version of this document that is accessed from the Studio for Analysts'
Help menu.

Corticon Studio Tutorial:
Advanced Rule Modeling

Introduces Corticon's direct database access with a detailed
walkthrough from development in Studio to deployment on Server.
Uses Microsoft SQL Server to demonstrate database read-only and
read-update functions.

Corticon Tutorial: Using
Enterprise Data
Connector (EDC)
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Corticon Studio Documentation: Defining and Modeling Business Rules

Step-by-step procedures for installing Corticon Studio and Corticon
Studio for Analysts on computers running Microsoft Windows. Also
shows how use other supported Eclipse installations for integrated
development. Shows how to enable internationalization on Windows.

Corticon Studio:
Installation Guide

Presents the concepts and purposes the Corticon Vocabulary, then
shows how to work with it in Rulesheets by using scope, filters,
conditions, collections, and calculations. Discusses chaining, looping,
dependencies, filters and preconditions in rules. Presents the Enterprise
Data Connector from a rules viewpoint, and then shows how database
queries work. Provides information on versioning, natural language,
reporting, and localizing. Provides troubleshooting and many Test
Yourself exercises.

Corticon Studio: Rule
Modeling Guide

Reference guide to the Corticon Studio user interface and its
mechanics, including descriptions of all menu options, buttons, and
actions.

Corticon Studio: Quick
Reference Guide

Reference information for all operators available in the Corticon Studio
Vocabulary. A Rulesheet example is provided for many of the operators.
Includes special syntax issues, handling arithmetic and character
precedence issues.

Corticon Studio: Rule
Language Guide

Detailed technical information about the Corticon extension framework
for extended operators and service call-outs. Describes several types
of operator extensions, and how to create a custom extension plug-in.

Corticon Studio:
Extensions Guide

Corticon Server Documentation: Deploying Rules as Decision Services

Details installing the Corticon Server as a Web Services Server, and
then and deploying and exposing Decision Services as Web Services
on Tomcat and other Java-based servers. Presents the features and
functions of the browser-based Server Console.

Corticon Server:
Deploying Web Services
with Java

A step-by-step introduction to installing the Corticon Server as a Web
Services Server and deploying and exposing decisions as Web
Services with .NET. Provides installation and configuration information
for the .NET Framework and Internet Information Services on various
supported Windows platforms.

Corticon Server:
Deploying Web Services
with .NET

An in-depth, technical description of Corticon Server deployment
methods, including preparation and deployment of Decision Services
and Service Contracts through the Deployment Console tool. Discusses
relational database concepts and implementation of the Enterprise
Data Connector. Goes deep into the server to discuss state,
persistence, and invocations by version or effective date. Includes
samples, server monitoring techniques, and recommendations for
performance tuning.

Corticon Server:
Integration & Deployment
Guide
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Overview of Progress Corticon
Progress® Corticon® is the Business Rules Management System with the patented "no-coding"
rules engine that automates sophisticated decision processes.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server deployment environments.

• Corticon Studios are the Windows-based development environment for creating and testing
business rules:

• Corticon Studio for Analysts. is a standalone application, a lightweight installation that
focuses exclusively on Corticon.

• Corticon Studio is the Corticon Designer perspective in the Progress Developer Studio
(PDS), an industry-standard Eclipse 3.7.1 and Java 7 development environment. The PDS
enables integrated applications with other products such as Progress OpenEdge and Progress
Apama.

The functionality of the two Studios is virtually identical, and the documentation is appropriate
to either product. Documentation of features that are only in the Corticon Designer (such as on
integrated application development and Java compilation) will note that requirement. Refer to
the Corticon Studio: Installation Guide to access, prepare, and install each of the Corticon
Studio packages.

Studio Licensing - Corticon embeds a time-delimited evaluation license that enables
development of both rule modeling and Enterprise Data Connector (EDC) projects, as well as
testing of the projects in an embedded Axis test server.You must obtain studio development
licenses from your Progress representative.

• Corticon Servers implement web services for business rules defined in Corticon Studios:

• Corticon Server for deploying web services with Java is supported on various application
servers, and client web browsers. After installation on a supported Windows platform, that
server installation's deployment artifacts can be redeployed on various UNIX and Linux web
service platforms as Corticon Decision Services.The guide Corticon Server: Deploying web
services with Java provides details on the full set of platforms and web service software that
it supports, as well as installation instructions in a tutorial format for typical usage.

• Corticon Server for deploying web services with .NET facilitates deployment of Corticon
Decision Services on Windows .NET Framework 4.0 and Microsoft Internet Information
Services (IIS).The guide Corticon Server: Deploying web services with .NET provides details
on the platforms and web service software that it supports, as well as installation instructions
in a tutorial format for typical usage.

Server Licensing - Corticon embeds a time-delimited evaluation license that enables evaluation
and testing of rule modeling projects on supported platform configurations.You must obtain
server deployment licenses and server licenses that enable the Enterprise Data Connector
(EDC) from your Progress representative.
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1
Supported configurations

Certified on VersionSoftware Component

JDK 1.7.0_05JDK

Indigo SR1 3.7.1Eclipse

2.7.0EMF

3.7.1GEF

1.5.0GMF
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2
Overview

You can extend the set of operators available to your users by writing your own Java classes.

Example InvocationDescriptionExtension

Customer.zip.characterAt(2)

String Attribute Extended
Operator characterAt returns
a String consisting of the
second character of
Customer.zip.

Extensions that you invoke
against attributes of a given
type. For example, you can
define an extension that can be
invoked against String
attributes.

Attribute Extended Operator

Order.uni=
orditm.sku->uniqueCount

Collection Extended Operator
uniqueCount returns a count
of the number of unique String
values in collection
orditem.sku.

Extensions that operate on
collections. For example, you
can define an extension that
can be invoked against a
collection of String attributes.

Collection Extended Operator
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Example InvocationDescriptionExtension

Trade.mavg=
security.price->sortedBy(marketDate)
->mavg(30)

Sequence Extended Operator
mavg returns the moving
average of a sequence of price
values in security.price.

Extensions that operate on
sequences. For example, you
can define an extension that
can be invoked against a
sequence Decimal attributes.

Sequence Extended Operator

Shape.circumference =
SeMath.getCircumference
(Shape.radius)

Stand-Alone Extension

SeMath.getCircumference
converts Shape.radius to
Shape.circumference.

Function you can use in any
Rulesheet expression. A
Stand-Alone extension can take
any number of input parameters
returns a value.

Stand-Alone Extended Operator

Service Call-out Extension
CreditLookup retrieves credit
data from a consumer credit
agency and updates rule engine
facts accordingly. The system
forwards the updated facts to
Rulesheet AssessRisk for
analysis.

Extensions you can use in a
Ruleflow. A Service Call-out is
an extension that can directly
access and update the universe
of rule engine facts via the
Service Call-out application
programming interfaces.

Service Call-out Extension

There are several ways to add your extension classes to the system. The approach you use
depends on whether you are using Progress Corticon Studio in Eclipse, Progress Corticon Studio
for Analysts, or the Foundation APIs in a non-Eclipse setting.
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3
Java class conventions

Your extension classes must conform to certain standards. Although you are free to choose any
package and class names for your extensions, your classes must implement special marker
interfaces to identify them as containers of extension logic:

DescriptionInterface Name
com.corticon.services.extensions.

Identifies your class as a container of String Attribute
Extended Operators.

ICcStringExtension

Identifies your class as a container of Date, Time and/or
DateTime Attribute Extended Operators.

ICcDateTimeExtension

Identifies your class as a container of Decimal Attribute
Extended Operators.

ICcDecimalExtension

Identifies your class as a container of Integer Attribute
Extended Operators.

ICcIntegerExtension

Identifies your class as a container of Collection
Extended Operators.

ICcCollectionExtension

Identifies your class as a container of Sequence
Extended Operators.

ICcSequenceExtension
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DescriptionInterface Name
com.corticon.services.extensions.

Identifies your class as a container of Stand-Alone
Extended Operators

ICcStandAloneExtension

Identifies your class as a container of Service Call-out
Extensions.

ICcServiceCalloutExtension

These marker interfaces can be found in:

LocationUsage Scenario

Eclipse plug-in com.corticon.servicesEclipse or RCP

Corticon_eFoundation_API.jarFoundation API

Corticon Studio 5.3 is installed with source code examples that illustrate the proper implementation
for each type of extension.

Refer to the source code examples in the Extended Operators and Service Call-outs
folders.
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4
Attribute extended operators

Attribute Extended Operators apply to specific attribute data types. Consider this example Rulesheet
expression:

Customer.fullName = Customer.name.trimSpaces

Assuming that Customer.name is a String attribute, Attribute Extended Operator trimSpaces
might perform the “trim” function on the value of attribute name, returning the trimmed value, which
the rule engine will assign to Customer.fullname.

To create an Attribute Extended Operator, you must code a Java class, and your class must
implement the marker interface corresponding to the attribute type. For example, to create a String
Attribute Extended Operator, your Java class must implement interface ICcStringExtension.
Example:

package com.acme.extensions;

import com.corticon.services.extensions.ICcStringExtension;

public class S1String implements ICcStringExtension
{

public static String trimSpaces(String astrThis)
{

if (astrThis == null)
{

return null;
}
return astrThis.trim();

}
}

Attribute Extended Operator methods must be declared public static.
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The first positional parameter will always be a reference to the attribute upon which the function
is being performed. In this example, the rules engine will pass the current value of Customer.name
to extension method trimSpaces as parameter astrThis; thus, astrThis must be declared
as type String.

An Attribute Extended Operator may accept any number of additional parameters as needed.
Consider the following Rulesheet expression:

Customer.initial = Customer.name.characterAt(1)

In this example, your Java method would return the first character of Customer.name:

public static String characterAt(String astrThis, BigInteger abiIndex)
{

if (abiIndex == null)
{

return null;
}

int liIndex = abiIndex.intValue() - 1;

if (liIndex < 0 || liIndex >= astrThis.length())
{

return null;
}

return astrThis.substring(liIndex, liIndex + 1);
}

As always, the first positional parameter astrThis will contain a reference to the String upon
which to operate (i.e., a reference to the value of Customer.name). The second parameter will
contain the character index (i.e., literal 1).

Your extension would return the character at the specified index as a String, and the rules engine
will assign Customer.initial the value of your returned String.

For Attribute Extended Operators, you must limit your parameter and return types to the following:

Corticon TypeJava Type

Integerjava.math.BigInteger

Decimaljava.math.BigDecimal

Booleanjava.lang.Boolean

Date, Time or DateTimejava.util.Date

Stringjava.lang.String

Note that you may code any number of extension methods in a Java class, and you can supply
one or more Java classes; regardless, the system will discover all of your methods via Java
reflection.
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5
Collection extended operators

Collection Extended Operators process a collection of input attribute values and return a single
value. Consider this example expression:

ord.asteriskFlag = orditem.sku->allContain(‘*’)

Assuming that asteriskFlag is a Boolean attribute and orditem.sku refers to a collection of
String attributes, Collection Extended Operator allContain will return a Boolean value true if all
instances of String attribute sku contain an asterisk.
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To create a Collection Extended Operator, you must code a Java class, and your class must
implement marker interface ICcCollectionExtension. Example:

package com.corticon.operations.extended.examples.operators.set1;

import java.util.HashSet;

import com.corticon.services.extensions.ICcCollectionExtension;

public class S1Collection implements ICcCollectionExtension
{

public static Boolean allContain(String[] astrInputArray, String astrLookFor)

{
if (astrInputArray == null || astrInputArray.length == 0)

return null;

for (String lstrInput : astrInputArray)
{

if (lstrInput != null)
{

if (lstrInput.indexOf(astrLookFor) < 0)
{

return new Boolean(false);
}

}
}

return new Boolean(true);
}

}

Collection Extended Operator methods must be declared public static.

In this example, the first positional parameter of method allContain is an array of String instances.
The rules engine will populate this array with the String values in orditem.sku (i.e., the collection
upon which the method operates).

The example Java method analyzes this array and returns a Boolean value. The rules engine will
then assign ord.asteriskFlag the Boolean return value.

Note that you cannot code Collection Extended Operators for entity instances, nor can you code
extensions for Collections or Sequences of entity instances. For example, the following expression
is not allowed:

orditem->allContain(‘*’)

In other words, you can only code Collection Extended Operators to process collections of attribute
values.

When implementing Collection Extended Operators, you must limit your parameter and return
types to the following:

Corticon TypeJava Type

Integerjava.math.BigInteger

Decimaljava.math.BigDecimal

Booleanjava.lang.Boolean

Date, Time or DateTimejava.util.Date

Stringjava.lang.String
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The first positional parameter must be an array of one of these allowable types.
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6
Sequence extended operators

Sequence Extended Operators process a sequence (list) of input attribute values and return a
single value. Consider this example expression:

Trade.mavg=security.price->sortedBy(marketDate)->mavg(30)

Assuming that Trade.mavg is a Decimal attribute, marketDate a Date attribute, and
security.price refers to a collection of Decimal attributes, Sequence Extended Operator mavg
might return a Decimal value that is the moving average of the first 30 instances of sequence
security.price.
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To create a Sequence Extended Operator, you must code a Java class, and your class must
implement marker interface ICcSequenceExtension. Example:

package com.corticon.operations.extended.examples.operators.set1;

import java.math.BigDecimal;
import java.math.BigInteger;

import com.corticon.services.extensions.ICcSequenceExtension;

public class S1Sequence implements ICcSequenceExtension
{

private static final int DECIMAL_SCALE = 4;

public static BigDecimal mavg(BigDecimal[] abdInputArray, BigInteger
abiElements)

{
if (abdInputArray == null || abiElements == null)
{

return new BigDecimal(“0”);
}

int liElements = abiElements.intValue();

BigDecimal lbdSum = new BigDecimal(“0”).setScale(DECIMAL_SCALE);
int liDenominator = 0;
for (int liIndex = 0; liIndex < abdInputArray.length &&
liIndex < liElements; liIndex++)
{

lbdSum = lbdSum.add(abdInputArray[liIndex]);
liDenominator++;

}

BigDecimal lbdDenominator = new BigDecimal(String.valueOf(liDenominator));

return lbdSum.divide(lbdDenominator, DECIMAL_SCALE,
BigDecimal.ROUND_HALF_UP);

}
}

Sequence Extended Operator methods must be declared public static.

In this example, the first positional parameter of method mavg is an array of BigDecimal instances.
The rules engine will populate this array with the Decimal values in security.price (that is,
the sequence upon which the method operates).

Note:  Collection security.price has been sorted into marketDate sequence via built-in
operator sortedBy.

The example Java method analyzes this array and returns a Decimal value. The rules engine will
then assign Trade.mavg the Decimal return value.

As with Collection Extended Operators, you cannot code Sequence Extended Operators for entity
instances, nor can you code extensions for Collections or Sequences of entity instances.

When implementing Sequence Extended Operators, you must limit your parameter and return
types to the following:
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Corticon TypeJava Type

Integerjava.math.BigInteger

Decimaljava.math.BigDecimal

Booleanjava.lang.Boolean

Date, Time or DateTimejava.util.Date

Stringjava.lang.String

The first positional parameter must be an array of one of these allowable types.
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7
Stand-alone extended operators

Stand-alone extended operators define functions that can be used in Rulesheet expressions. Unlike
Attribute Extended Operators, they are not tied to Vocabulary attributes and are not associated
with any particular data type.

Users invoke Stand-Alone extended operators by explicitly specifying a class name and method
name in Rulesheet expressions.1

Stand Alone extension classes may contain any number of static methods.

Consider this expression:

Circle.circumference = SeMath.getCircumference(Circle.radius)

Assuming Circle.circumference and Circle.radius are both Decimal attributes,
Stand-Alone Extended Operator SeMath.getCircumference might convert the radius to
circumference, which the rule engine will assign to Circle.circumference.

To create Stand Alone Extended Operator, you must code a Java class, and your class must
interface ICcStandAloneExtension. Example:

package com.corticon.operations.extended.examples.standalone.set1;

import java.math.BigDecimal;

import com.corticon.services.extensions.ICcStandAloneExtension;

public class SeMath implements ICcStandAloneExtension
{

public static BigDecimal getCircumference(BigDecimal abdRadius)
{

BigDecimal lbdBigDecimal = abdRadius.multiply(new BigDecimal(2.0));
lbdBigDecimal = lbdBigDecimal.multiply(new BigDecimal(Math.PI));
return lbdBigDecimal;

}
}
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Stand-Alone Extended Operator methods must be declared public static. Any number of
parameters may be specified. The Rulesheet expression parameter list and return value must
match the extension class method signature; otherwise, the Rulesheet expression will be flagged
as invalid.

In this example, the rules engine will pass the current value of Circle.radius to class
com.corticon.operations.extended.examples.standalone.set1.SeMath method
getCircumference as parameter abdRadius; thus, abdRadius must be declared as type
BigDecimal.

Similarly to Attribute Extended Operators, you must limit parameter and return types to the following:

Corticon TypeJava Type

Integerjava.math.BigInteger

Decimaljava.math.BigDecimal

Booleanjava.lang.Boolean

Date, Time or DateTimejava.util.Date

Stringjava.lang.String

Note that you may code any number of extension methods in a Java class, and you can supply
one or more Java classes; regardless, the system will discover all of your methods via Java
reflection.

1 The user specifies the unqualified part of the class name, namely the class name without the package name.
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8
Service call-out extensions

Service Call-out Extensions are user-written functions that can be invoked in a Ruleflow.

In a Ruleflow, the flow of control moves from Rulesheet to Rulesheet, with all Rulesheets operating
on a common pool of facts. This common pool of facts is retained in the rule execution engine's
working memory for the duration of the transaction. Connection arrows on the diagram specify the
flow of control. Each Rulesheet in the flow may update the fact pool.

When you add a Service Call-out to a Ruleflow diagram, you effectively instruct the system to
transfer control to your extension class a specific point in the flow.Your extension class can directly
update the fact pool, and your updated facts are available to subsequent Rulesheets.

Consider this example:

After the rule engine finishes processing Rulesheet SelectCandidates, it will transfer control
to Service Call-out Extension class CreditLookup, method retrieveFICO.

Using the Service Call-out API, class CreditLookup, method retrieveFICO can create, retrieve,
update and remove facts. For example, it might look up a customer's FICO score using an external
web service, and update the facts accordingly.

When CreditLookup.retrieveFICO finishes, the system will transfer control to the next
Rulesheet in the Ruleflow. Downstream Rulesheets (for example, AssessRisks) will evaluate
and respond to new facts asserted by your Service Call-out.
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9
Service call-out API

Your Service Call-outs use an API to retrieve and update facts. The API is comprised of these
Java interfaces:

PurposeInterface

Provides access to the entire fact
pool. Allows you to create, retrieve
and remove entity instances.

com.corticon.services.dataobject.ICcDataObjectManager

Provides access to a single entity
instance. Allows you to update the
entity instance, including setting
attributes and creating and
removing associations.

com.corticon.services.dataobject.ICcDataObject

These interfaces can be found in:

LocationUsage Scenario

Eclipse plug-in com.corticon.servicesEclipse or RCP

Corticon_eFoundation_API.jarFoundation API

Your Service Call-out class must implement marker interface ICcServiceCalloutExtension.
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Example:

package com.corticon.operations.extended.examples.servicecallouts;

import com.corticon.services.dataobject.ICcDataObject;
import com.corticon.services.dataobject.ICcDataObjectManager;
import com.corticon.services.extensions.ICcServiceCalloutExtension;

public class SampleDataService implements ICcServiceCalloutExtension
{

public static void retrievePersonInfo(ICcDataObjectManager aDataObjMgr)
{

for (ICcDataObject lPerson : aDataObjMgr.getEntitiesByName(“Person”))
{

String lstrName = “Tom”;
Boolean lbMarried = new Boolean(true);

lPerson.setAttributeValue(“name”, lstrName);
lPerson.setAttributeValue(“married”, lbMarried);

}
}

}

Service Call-out methods must be declared public static.

The system will recognize your Service Call-out method if the method signature takes one parameter
and that parameter is an instance of ICcDataObjectManager.

Recognized classes and methods will appear in the Ruleflow Properties View/Service Name
drop-down list when a Service Call-out shape is selected in the Ruleflow diagram:

Example SampleDataService.resetInfoCounter illustrates how a Service Call-out can use
the supplied ICcDataObjectManager to find and update entity instances.

ICcDataObjectManager method getEntitiesByName allows you to retrieve a Set of all entity
instances with a given name. Each element of the returned Set is an instance of ICcDataObject
which offers additional methods to access and update a specific entity instance.

The example finds all Person entities then iterates over them to set attributes Person.name and
Person.married using generic method ICcDataObject.setAttributeValue.
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The Service Call-out API provides your extension class complete access to the fact pool, allowing
you to:

• Find entities in several ways

• Read and update entity attributes

• Create and remove entity instances

• Create and remove associations

• Post rule messages

Refer to Service Call-out Java source code examples in your Corticon Studio /Samples/Extended
Operators folder, and see the API Javadocs for more information.
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10
Creating an extension plug-in

For Eclipse and RCP deployment, you must create an Eclipse plug-in to encapsulate your
extensions. The system will automatically recognize an optional plug-in named:

com.corticon.eclipse.studio.operations.extended.core

You can use your Eclipse IDE to create a plug-in project to develop your extensions and ultimately
prepare them for deployment.

For details, see the following topics:

• Setting up your development Eclipse IDE

• Creating your plug-in project

• Creating the extension locator file

• Creating an extension class

• Coding your extension class

• Updating your plug-in manifest

• Organizing imports

• Exporting your plug-in

• Installing your plug-in

• Testing your extension

• Troubleshooting extensions

• Extension plug-in not resolved by Eclipse

• Extension locator file not set up correctly
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• Extension classes not implementing marker interfaces

• Enabling logging to diagnose extensions issues

Setting up your development Eclipse IDE
This topic applies to users of PDS Corticon Studio, not users of Corticon Studio for Analysts.

To develop plug-ins, you must use the Java Development Kit (JDK), not just a Java Runtime
Environment (JRE).

1. Download and install a supported JDK from www.oracle.com

2. Select Window > Preferences > Java > Installed JREs

3. Navigate to your downloaded JDK and select it as your default JRE.

4. Copy tools.jar from your JDK's /lib directory into /jre/lib/ext so that you can compile
and test Rulesheets, .

Creating your plug-in project
To create a plug-in project:

1. Using the Java Perspective select:

Select New > Project > Plug-in Project.

2. Click Next
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3. Specify the Plug-in Project name
com.corticon.eclipse.studio.operations.extended.core.

4. Click Next.

The Content dialog opens.
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5. In the Content dialog:

a) In the Version field, enter a version number for your plug-in.You should specify a version
greater than the version of Studio you installed. For example, if you installed Studio Version
5.3.0, you might specify version 5.3.2. This will ensure that your plug-in supersedes our
example plug-in.

b) In the Name field, enter Extended Operators Core Plug-in.
c) In the Provider field, enter your company name.
d) Uncheck Generate an activator.
e) Uncheck This plug-in will make contributions to the UI.
f) Click Finish to close the dialog.

6. When prompted to switch to the Plug-in Development perspective, check Remember my
decision, as shown:

7. Click Yes.

The system switches to Plug-in Development perspective, and then creates a new plug-in
project in your workspace.
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8. The plug-in manifest  file (MANIFEST.MF) opens to let you configure the new plug-in:

9. Close the plug-in manifest editor. (This task will be completed later.)

Creating the extension locator file
Right click on the /src node in the Package Explorer and select New > File

The system will prompt for a new file name. Specify CcExtensionsLocator.lc as shown:
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Press Finish to proceed.

Creating an extension class
Right click on the /src node in the Package Explorer and select New > Package. Specify the
package name for your new extension classes:

Press Finish to proceed.

Right-click on your new package and select New > Class:
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Enter a name for your new Java class (for example, HelloWorld) and press Finish. The system
will create an empty class definition:
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Coding your extension class
Code your extension class as shown:

package com.acme.extended.operators;

public class HelloWorld implements ICcStringExtension
{

public static String getHelloWorld(String astrThis)
{

return "Hello World";
}

}

Note that Eclipse cannot resolve interface ICcStringExtension:
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Updating your plug-in manifest
To correct build errors, open MANIFEST.MF located in your new plug-in META-INF directory, and
then select the MANIFEST.MF tab and update the manifest as shown in italics below:

Manifest-Version: 1.0
Bundle-ManifestVersion: 2
Bundle-Name: Extended Operators Core Plug-in
Bundle-SymbolicName: com.corticon.eclipse.studio.operations.extended.core
Bundle-Version: 5.3.0
Bundle-Vendor: Your Company
Bundle-RequiredExecutionEnvironment: JavaSE-1.7
Require-Bundle: org.eclipse.core.runtime,
com.corticon.legacy,
com.corticon.services,
com.corticon.thirdparty
Export-Package: .,
com.acme.extended.operators
Eclipse-RegisterBuddy: com.corticon.legacy

These changes will:

• Ensure that your plug-in has access to interface ICcStringExtension in
com.corticon.services

• Ensure that your locator file CcExtensionLocator.lc and Java package
com.acme.extended.operators are visible to the Corticon extensions subsystem

• Ensure that your plug-in is registered as a “buddy” with com.corticon.legacy to allow the
Corticon class loader to find your extensions

Click Save to save your manifest changes.

Organizing imports
Activate the HelloWorld Java editor and press CTRL-SHIFT-O to organize imports. The system
will add import com.corticon.services.extensions.ICcStringExtension allowing your
class to build without errors:
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Exporting your plug-in
Close all open editors, right-click your Project in the Package Explorer view and select:

Export… > Plug-in Development > Deployable plug-ins and fragments:
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Navigate to your preferred output directory, and then click Finish.

An installable plug-in is created in your output directory:

Installing your plug-in
Copy your exported plug-in into the target Eclipse environment /plugins directory.

It is important that you restart your target Eclipse environment with administrator privileges
whenever you update your plug-in so that the plug-in gets properly installed and registered.

It is a good practice to use the –clean command line option when you restart Eclipse to force the
system to rebuild the bundle cache, ensuring that your changes take effect.
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Testing your extension
Create a Rule Project as a home for your Corticon test assets. Switch to Corticon Designer
perspective by selecting:

Window > Open Perspective > Other > Corticon Designer, and then click OK. The system
rearranges the editors and views as shown:

Right-click in the body of the Rule Project Explorer and select New > Rule Project
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Enter HelloWorld in the Project name field and press Finish.

The system will create a new Rule Project visible in the Rule Project Explorer:

Right-click the HelloWorld project and select New > Rule Vocabulary:
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Enter HelloWorld in the File name field and press Finish.

The system will create a new Vocabulary:
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In the Vocabulary Editor, right-click the HelloWorld root node and select Add Entity to create a
new entity Customer:

Right click Customer and select Add Attribute to create String attribute name:
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Press Save to save your new Vocabulary.

Select the HelloWorld project in the Rule Project Explorer and select New > Rulesheet:

Press Next and then select the Vocabulary asset you created in the prior step:
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Press Finish and the system will create a new empty Rulesheet.

Update your Rulesheet as shown:

Press Save to save your Rulesheet.
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Right click on your HelloWorld project and select New > Ruletest. Specify HelloWorld in the
File name field:

Press Next.

Select your Rulesheet HelloWorld.ers as the Test Subject:
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Press Finish and the system will create an empty Ruletest asset.
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Drag entity Customer from the Vocabulary view to the Ruletest input tree:
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Important:  Double-click Customer[1] name and enter value Test.

Select Ruletest > Testsheet > Run Test and you should see the following test results:
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If you see Hello World in the output tree, congratulations! Your extensions are working properly.

Troubleshooting extensions
If your extensions are not properly written or deployed, the system will color Rulesheet expressions
red and will display validation messages in the Problems tab:
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For Attribute Extended Operators, validation messages will indicate that your method is not a valid
call on an attribute. There are several possible causes for this type of error.

Extension plug-in not resolved by Eclipse
Your plug-in might not be properly started and resolved by Eclipse. One quick way to check this
is to select:

Help > About Progress Developer Studio > [Installation Details] > [Configuration]

then check the Plug-in Registry to see the status of your extensions plug-in:

com.corticon.eclipse.studio.deployment.ui (5.3.2) "Deployment UI" [Starting]
com.corticon.eclipse.studio.drivers.core (5.3.2) "Drivers Core" [Starting]
com.corticon.eclipse.studio.drivers.datadirect.core (5.3.2) "Drivers DataDirect
Core" [Starting]
com.corticon.eclipse.studio.extension.core (5.3.2) "Vocabulary Extension Core
Plug-in" [Starting]
com.corticon.eclipse.studio.operations.extended.core (5.3.2) "Extended Operators
Core Plug-in" [Resolved]
com.corticon.eclipse.studio.extension.ui (5.3.2) "Vocabulary Extension UI
Plug-in" [Active]
com.corticon.eclipse.studio.importwizards.core (5.3.2) "Import Wizards Core"
[Starting]
com.corticon.eclipse.studio.junit.core (5.3.2) "JUnit Core" [Starting]

In this example, the plug-in has been installed and properly [Resolved].
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If your plug-in is missing from this list, ensure that you have properly copied it into the Eclipse
/plugins directory.

Remember to start Eclipse with the –clean commandline option.This forces the system to rebuild
the bundle cache so that your new plug-in code is recognized.

If your plug-in is present in the list but not marked as [Resolved] there may be some problem
with the plug-in manifest. Carefully review MANIFST.MF to ensure all of your specifications are
correct.

Tips for troubleshooting bundle start failures can be found in various Eclipse online forums.

Extension locator file not set up correctly
If your plug-in has been correctly [Resolved], ensure that your extension classes implement the
correct marker interface(s) and that CcExtensionsLocator.lc is present in the root of your
plug-in Jar.

Also, review the MANIFEST.MF Export-Package clause carefully. It should appear as follows:

Export-Package:

com.acme.extended.operators;

Note that in the Export-Package clause, you must export period(.) to ensure that
CcExtensionsLocator.lc is properly exported. If this specification is in error or missing, the
system will fail to locate your classes.

Extension classes not implementing marker interfaces
Ensure that your classes implement the proper marker interfaces (for example,
ICcStringExtension); otherwise, the extensions subsystem will ignore your class.

Enabling logging to diagnose extensions issues
You can enable INFO-level logging to help diagnose extensions discovery issues.

Update com.corticon.configuration/CcCommon.properties to set loglevel to INFO:

loglevel=INFO

The extensions subsystem will log messages as it tries to locate your extension classes.
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You might see this type of output if your plug-in fails to properly export(.):

CcUtil.getAllLocationsOfFile() .. START
CcUtil.getAllLocationsOfFile() .. astrResourceName = CcExtensionsLocator.lc
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromJars() ==
Start
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromJars()
asetJarLocations == []
CcUtil|CcUtil.getAllLocationsOfFile() .. START
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromDirectories()
== Start
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromDirectories()
asetDirectoryLocations == []

In the log output above, the extensions subsystem is unable to find CcExtensionsLocator.lc
either because it is missing or not properly exported.

In contrast, here is what you will see in the log if the extensions subsystem is able to find your
locator and extension classes:

CcUtil.getAllLocationsOfFile() .. START
CcUtil.getAllLocationsOfFile() .. astrResourceName = CcExtensionsLocator.lc
CcUtil.getAllLocationsOfFile() .. lURLLocationPath =
bundleresource://17.fwk25860399/CcExtensionsLocator.lc

CcUtil.getAllLocationsOfFile() .. lstrProtocol = bundleresource
CcUtil.getAllLocationsOfFile( AFTER RESOLVER ) .. lURLLocationPath =
jar:file:/C:/Program Files (x86)/Progress/Corticon
5.3/Studio/eclipse/plugins/com.corticon.eclipse.studio.operations.extended.core

_5.3.0.jar!/CcExtensionsLocator.lc
CcUtil.getAllLocationsOfFile(1) .. lstrPath =
file:\C:\Program Files (x86)\Progress\Corticon
5.3\plugins\com.corticon.eclipse.studio.operations.extended.core
_5.3.0.jar!\CcExtensionsLocator.lc
CcUtil.getAllLocationsOfFile(2) .. lstrPath =
file:\C:\Program Files (x86)\Progress\Corticon
5.3\plugins\com.corticon.eclipse.studio.operations.extended.core
_5.3.0.jar!\CcExtensionsLocator.lc
CcUtil|CcUtil.getAllLocationsOfFile() .. END =
[file:\C:\Program Files (x86)\Progress\Corticon
5.3\plugins\com.corticon.eclipse.studio.operations.extended.core
_5.3.0.jar!\CcExtensionsLocator.lc]
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromDirectories()
== Start
com.corticon.extensions.CcExtensions|CcExtensions() loadClassesFromDirectories()
asetDirectoryLocations == []

As shown above, getAllLocationsOfFile is able to find your extensions. This is a positive
sign and if you see such output in the log, it is very likely that your extensions will work properly.
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11
Documenting your extensions

In order for your extensions to be visible in the Rule Operators tree view, they must be properly
documented in a special file named ExtendedOperators.operationsmodel. This file is in
EMF/XMI format and can be maintained using either a text editor an EMF-generated editor supplied
with Corticon Studio. Refer to the example ExtendedOperators.operationsmodel file in:

com.corticon.eclipse.studio.operations.extended.core

During system initialization, the system will attempt to locate
ExtendedOperators.operationsmodel on the Java class path; if the system finds this file,
it will automatically merge the documented extended operators into the Rule Operators tree view.

ExtendedOperators.operationsmodel supports internationalization. The object model
permits localization of folder names, extended operator names, parameter names and tooltips.
This is accomplished via EMF “multi-valued” attributes, which are essentially lists (arrays) of values.
Each “slot” in the array contains a particular localization (i.e., a string expressed in one of the
supported languages).

The first localization in each “slot” is special and is referred to as the “base” localization. For class
and method names, the “base” localizations must match the class and method names in your java
extension classes.

The root object of the model (ExtendedOperatorSet) contains a list of Java LanguageCode
instances that defines the set of languages supported. The order of language codes is important
and must match the order of localizations expressed elsewhere in the file.

The system will merge typed extensions into the Rule Operator tree at the end of the built-in
operators. For example, String Attribute Extended Operators will be appended to the “String” data
type node of the Rule Operator tree after the built-in String operators.
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The system will append Stand Alone extensions to the end of the Rule Operator tree. The Stand
Alone extensions will be contained within a special folder whose name is declared in
ExtendedOperators.operationsmodel (see ExtendedOperatorSet.standAloneFolderName).
In our example, the name of the Stand Alone extensions folder is simply Extended Operators.

Our example ExtendedOperators.operationsmodel contains English descriptions of
operators, and is set up to handle Japanese localizations as well, although the only Japanese
localization specified is the Stand Alone folder name.

Refer to example ExtendedOperators.operationsmodel file as a guide documenting your
own extensions.
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12
Precompiling ruleflows with service call-outs

As described in the “Deploying Corticon Ruleflows” chapter of the Server Integration & Deployment
Guide, you can pre-compile Ruleflows prior to deploying them.When pre-compiling Ruleflows with
Service Call-outs, it is important to ensure the following:

1. Place the SCO JARs on the Deployment Console's classpath. This is accomplished by editing
the deployConsole.bat file located in [CORTICON_HOME]\Server (or your chosen
installation directory).

2. Once the Ruleflow has been compiled to an .eds file using the Deployment Console, add your
.eds file, along with any other JARs required by the SCO, to the Server directory which holds
CcServer.jar. In the default Tomcat installation, this is
<yourTomcatHome>\axis\WEB-INF\lib.
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A
Third party acknowledgments

One or more products in the Progress Corticon v5.3.2 release includes third party components
covered by licenses that require that the following documentation notices be provided:

Progress Corticon v5.3.2 incorporates Apache Commons Discovery v0.2 from The Apache Software
Foundation. Such technology is subject to the following terms and conditions:The Apache Software
License, Version 1.1 - Copyright (c) 1999-2001 The Apache Software Foundation. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. The end-user documentation included with the redistribution, if any, must include the following
acknowlegement: "This product includes software developed by the Apache Software Foundation
(http://www.apache.org/)." Alternately, this acknowledgement may appear in the software itself, if
and wherever such third-party acknowledgements normally appear.

4.The names "The Jakarta Project", "Commons", and "Apache Software Foundation" must not be
used to endorse or promote products derived from this software without prior written permission.
For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache" nor may "Apache" appear in
their names without prior written permission of the Apache Group.
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THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache
Software Foundation. For more information on the Apache Software Foundation, please see
<http://www.apache.org/>.

Progress Corticon v5.3.2 incorporates Apache SOAP v2.3.1 from The Apache Software Foundation.
Such technology is subject to the following terms and conditions: The Apache Software License,
Version 1.1 Copyright (c) 1999 The Apache Software Foundation. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met: 1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. 3.The end-user documentation
included with the redistribution, if any, must include the following acknowledgment: "This product
includes software developed by the Apache Software Foundation (http://www.apache.org/)."
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear. 4. The names "SOAP" and "Apache Software Foundation"
must not be used to endorse or promote products derived from this software without prior written
permission. For written permission, please contact apache@apache.org. 5. Products derived from
this software may not be called "Apache", nor may "Apache" appear in their name, without prior
written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED ``AS
IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary
contributions made by many individuals on behalf of the Apache Software Foundation. For more
information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress Corticon v5.3.2 incorporates DOM4J v1.6.1. Such technology is subject to the following
terms and conditions: Project License BSD style license Copyright 2001-2005 (C) MetaStuff, Ltd.
All Rights Reserved.

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
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3.The name "DOM4J" must not be used to endorse or promote products derived from this Software
without prior written permission of MetaStuff, Ltd. For written permission, please contact
dom4j-info@metastuff.com.

4. Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark
of MetaStuff, Ltd.

5. Due credit should be given to the DOM4J Project - http://www.dom4j.org

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT,

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress Corticon v5.3.2 incorporates Jaxen v1.0. Such technology is subject to the following
terms and conditions: JAXEN License - $Id: LICENSE,v 1.3 2002/04/22 11:38:45 jstrachan Exp $
- Copyright (C) 2000-2002 bob mcwhirter and James Strachan. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.

3. The name "Jaxen" must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called "Jaxen", nor may "Jaxen" appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the Jaxen Project (http://www.jaxen.org/)."
Alternatively, the acknowledgment may be graphical using the logos available at
http://www.jaxen.org/. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. This software consists of voluntary contributions made by many individuals on behalf
of the Jaxen Project and was originally created by bob mcwhirter <bob@werken.com> and James
Strachan <jstrachan@apache.org>. For more information on the Jaxen Project, please see
<http://www.jaxen.org/>.

67Progress Corticon: Extensions Guide: Version 5.3.2



Progress Corticon v5.3.2 incorporates JDOM v1.0 GA. Such technology is subject to the following
terms and conditions: $Id: LICENSE.txt,v 1.11 2004/02/06 09:32:57 jhunter Exp $ - Copyright (C)
2000-2004 Jason Hunter and Brett McLaughlin. All rights reserved. Redistribution and use in source
and binary forms, with or without modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.

3.The name "JDOM" must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact
<request_AT_jdom_DOT_org>.

4. Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their
name, without prior written permission from the JDOM Project Management
<request_AT_jdom_DOT_org>.

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the JDOM Project (http://www.jdom.org/)."

Alternatively, the acknowledgment may be graphical using the logos available at
http://www.jdom.org/images/logos. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by
many individuals on behalf of the JDOM Project and was originally created by Jason Hunter
<jhunter_AT_jdom_DOT_org> and Brett McLaughlin <brett_AT_jdom_DOT_org>. For more
information on the JDOM Project, please see <http://www.jdom.org/>.

Progress Corticon v5.3.2 incorporates Saxpath v1.0. Such technology is subject to the following
terms and conditions: Copyright (C) 2000-2002 werken digital. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.

3. The name "SAXPath" must not be used to endorse or promote products derived from this
software without prior written permission. For written permission, please contact
license@saxpath.org.

4. Products derived from this software may not be called "SAXPath", nor may "SAXPath" appear
in their name, without prior written permission from the SAXPath Project Management
(pm@saxpath.org).
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In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the SAXPath Project (http://www.saxpath.org/)."
Alternatively, the acknowledgment may be graphical using the logos available at
http://www.saxpath.org/ THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE SAXPath AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. This software consists of voluntary contributions made by many individuals on behalf
of the SAXPath Project and was originally created by bob mcwhirter <bob@werken.com> and
James Strachan <jstrachan@apache.org>. For more information on the SAXPath Project, please
see <http://www.saxpath.org/>.
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